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ntro to Google g3
)OCS fes

We acknowledge that we are located on Treaty One Territory and in
the heartland of the Métis Nation. We recognize the mistakes of the
past and believe in reconciliation, cooperation and moving forward

in partnership with Indigenous communities.
|
|
All content on GCFAprendelibre.org® is available

free of charge at https://edu.gcfglobal.orag/en/googledocuments/



https://edu.gcfglobal.org/en/googledocuments/

TECHMB

What is Tech Manitoba/Why is this free?

Tech Manitoba is a not-for-profit that aims to
help the tech industry in Manitoba flourish

TechMB’s digital literacy program provides free
computer courses

Federal funding allows us to provide these
courses for free: to help us continue to get

funding, please complete the survey after the
course
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Introduction '

[Instructor Name]
[Intructor email]
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What is your name?
Country of origin?

Students
Introduction

Occupation?
What do you expect to learn?
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Housekeeping tasks

e Registration Forms - Please fill out if not done already
e Media Release agreement — Please read and sign if you are willing to be photographed
e End of Course Survey - Will be done after completion of the course

e You MUST complete the survey at the end of the course to receive your certificate. Please
complete this survey as it allows us to get funding from the government and continue
delivering these free courses

e You will need to be signed into Google for this course
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Buttons are at the bottom left corner of your screen




TECHMB 5

How to use Zoom: MUTE & VIDEO

Microphone and Camera

ON
Click on the button to
mute/unmute or start/stop video. ! ~ -‘ ~
Mute Stop Video
A red line crossing through the Mlcrophonoe el Celins s
microphone or camera, means FF
that itis muted or off. 2 ~ P
Unmute Start Video

Important: Please mute yourself when you are not speaking, otherwise
everyone will be able to hear your background noise.

The mute shortcut is Alt + A
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How to use Zoom: VIDEO LAYOUT

Select the Speaker View when
the instructor is teaching.
mm Speaker View | i Gallery View
Select the Gallery view for Q&A
and when participating in
discussions.
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Intro to Google Docs
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Learning Outcomes for this course

» Get started using Google Drive

« Familiarize yourself with the Google Docs interface and create files

* Learn how to manipulate and format text, and add hyperlinks

* Learn how to use headers, footers, and page numbering

* Collaborate with others by sharing, using comments, track changes, and
version history
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Discussion

What types of files do you access
on a daily basis?

What devices do you access your
files from?

Can you think of any files you'd like
to sync across multiple devices?

What are a few situations where
you might want to collaborate on a
document with others?




TECHMB &5 Sign in to your Google account

Gmail Images =z w

®
* You will need a Google account to Eoud
get started. Create one if you Sign in
O haven'’t already at google.com with your Google Account

* Sign in to your account

Email or phone

‘ Forgot email?

Not your computer? Use Guest mode to sign in privately.




TECHMB A brief overview of Drive

 Once you are signed in, you can access At google.com:

Google Drive at drive.google.com or by oma images (355 4D
clicking the apps icon in the top left at P
google.com % o B'B

* Drive is great for backups, as it can store 0 o
any type of file, including pictures, pdfs, = T O
and MS Office files B M

* You can link Drive to your desktop with Wi il e
the desktop app to upload files directly T O ¢

Chat Contacts Drive

e % b

to Drive from your computer’s file
browser



https://www.google.com/drive/download/
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L Drive

Q Search in Drive

My Drive ~

» [B] MyDrive
4 E] Computers
2, shared with me

Recent

C]
{( Starred
m

Trash

Storage

9 GB of 15 GB used .
Buy storage

]

B

B computer building

You opened today

Pivot documentation

Pivot Resources

Personal Work Fall 2016 - 2...

Budget

Budget Media Lists

You shared today You edited in the past week

C‘ Photos BB Pivot Slack documentation

BB Journal/ Short Entries BB circ. writing

. Pics

Book Tracker Media Lists

A brief overview of Drive: Interface

Book Tracker

You edited in the past week

BB coverletters

. Memory Writing Exercise

Home buying comparison

Recipes

You opened in the past week

Last modified

BB  Reed Courses

BB sBackups

E Computer building

ﬂ
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l— New

L Drive Q  Search

M Privg +

Folder
ess
B File upload@
Folder upload
B Google Docs >
Google Sheets >
Google Slides > terly
id tod
More
Name
Back
& oIS Albums

You can

3.

A brief overview of Drive:

¢ Open X
« v 4 &> ThisPC > Documents > v U Search Documents Vo
Organize - New folder - M @
& Name Date modified
# Quick access : .
~. Andrew Lytle at The Sewanee Review 5/8/2018 3:17 PM
= Desktop b g B N
.. Andrew Lytle at The Sewanee Review_Final Draft %5/8/2018 3:28 PM
R Downloads  # ) Andrew Lytle at The Sewanee Review_recovered * 5/8/2018 3:27 PM
* Documents & animations_transition_pane 5/30/2018 4:33 PM
& Pictures »* ~. APatel Cover Letter 5/14/2018 12:43 PM
9 iCloud Drive (# AutoRecovery save of WP Report.asd 5/2/2018 1:07 PM
& Google Drive # = Business Memo_Brenda graphics 5/10/2018 9:35 AM
=) i 4, 1 . ™M
Autosaved Capt Business Trip Checklist /30/2018 12:23 P
- i B %
File name: Andrew Lytle at The Sewanee Review v All Files >

‘ Drive

My Drive

Computers

Shared with me

Recent

Starred

Trash

Uploading

Q, Search Drive
My Drive ~
Name 1
BB ElenasFiles
Untouched Photos
Andrew Lytle at The Sewanee Review_Final Draft.docx %
Art Club Interest Letter <%

Newsletter

o o = B

also simply click and drag the files you want to upload into Drive,
or use the Drive desktop app

v



ane
TECHMB:K" Video: Getting started with Docs

GOOGLE DOCS
GETTING

STARTED



TECHMB& The Google Docs interface

Last edit was 3 minutes ago

~ ~ & A P 100% v Nomaltext ~ Meriweath. v - 9 + B I U A # o B~y =~

Updated Resume Aug22 ¥ &)
File Edit View Insert Format Tools Add-ons Help

4
4

Anthony Leong
WORK EXPERIENCE

Anthony Leong

Empirical research | Advocacy | Community Outreach | Empathy

Digital Literacy Program Coordi...

MAY 2021 - PRESENT

Community Support Technician ...

DECEMBER 2020 - APRIL 2021 WORK EXPERIENCE EDUCATION
. MSc (2016-2019), Bioscience,
Urban Researcher — Pivot 2020,... Digital Literacy Program Coordinator — Tech Manitoba, Technology, and Public Policy,
Winnipeg University of Winnipeg -
VOLUNTEER EXPERIENCE ! i
MAY 2021 - PRESENT Thesis on women'’s responses
Digital Outreach Volunteer — W... Coordinates logistics around training programs, including assisting with to infant cries

creating awareness, booking venues, securing facilitators, and preparing
course materials. Manages the computer giveaway program in
partnership with Computers for Schools. Maintains tracking and
reporting documents for funders and stakeholders.

BA (2012-2016), Psychology,
Reed College - Thesis on
public attitudes towards
neonatal male circumcision

PROJECTS

Anthony’s Book Reviews — Blod

EDUCATION




TECHMB& Creating & naming a new document

) My Drive - Google Drive X y Untitled document - Goc X \ N
& My g =] ( \

(& ‘ @ Secure | https://docs.google.com/document/d/1DNC

1. |- New 3.
E Untitled documentI [ |

File E Rename Insert Format Tools Add-ons Help

= T 100% - Normaltext - Arial -
T T SN NN SO S S TR SN SO SN NN T S T S S R
. L Drive Q  se
3 Folder
Fil upload | Quarterly Reporf/in I My Drive
Folder upload ; ==
. File [P preal/ Insert Format Tools
BN Sonoke toce 4 “~ ~om| P 100% ~ Normal text ~
Google Sheets > . : : -
Google Slides >
B Google Forms >
More >

There is no need to Save in Drive. Your files
are all automatically saved as you edit.
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I— New 2.

Template gallery

Resumes

A ‘Your Name

Resume Resume
3 Swiss Serif
Letters
Letter Letter

Spearmint Swiss

Resume
Coral

Business letter

Geometric

L Drive

Folder

File upload

Folder upload

Google Docs
Google Sheets

Google Slides

@
m
8
=]

Google Forms

More

Resume
Spearmint

'YOUR COMPANY

Business letter
Modern Writer

Creating a new document: Templates

Q  Searchin Drive

>
Blank document
>
From a template
>
> id today
>
Resume

Modern Writer

Hellofan,

Informal letter
Plum

You shared today
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Page setup

Thank You Letter ¢ &)

File Edit View Insert Format Tools

Make a co
24 nal text
1
Email >
Download >

Make available offline

Version history >

Rename
Move
¢ Add shortcut to Drive

Move to trash

Publish to the web

Document details
Language >
Page setup

= Print Ctrl+P

Page setup

Orientation argins (inches)

@ Portrait Landscape, To
N i

Paper size

Bottom 1
Letter (8.5"x11") ~

Page color

-

Set as default Cancel
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Practice!

e Navigate to Drive in your browser, create a new document
from a template, and rename it “Practice Document”

e (o back to Drive, create a folder, and put your document in it
e (Change the page orientation to landscape

e (Change all of the margin sizes to 0.5"

e (Change the page color to a light blue



TECHMB Text editing basics: Adding & selecting text

To insert text, locate the insertion point, which is a blinking
vertical line. When you type, text will be added here

June 28, 2018|

Before you can move or format text, you’ll need to select
it. Click and drag over the text, then release the mouse

Your donation will help us to reach this year’s fundraising goal of $10,000 to help support and
increase technology resources at Lakestone Montessori] As you may know, with the recent
budget cutbacks in education funding, this annual fundraiser is one of our most important events
of the school year. In addition to replacing aging computer equipment, we would like to

purchase 10 Apple iPads to help support the use of technology in expanding and exploring
lesson content.



TECHMB Text editing basics: Deleting text

There are several ways to delete text:

 To delete text to the left of the insertion point, press
the Backspace key

 To delete text to the right of the insertion point, press
the Delete key

» Select the text you want to remove, then press either
Delete or Backspace

If you select text and start typing, the selected text will
be deleted and replaced with the new text




TECHMB Text editing basics: Copy, cut, & paste
To copy and paste:

E Tee Off for Technology  ¥¢ e
File Edit View Insert Format Tools Add-ons

Y~ ~ @ = Undo Ctrl+Z

~4 Redo Ctrl+Y

[*] Paste Ctrl+V

[h Paste without formatting ~ Ctrl+Shift+V

Select all ctri+A ¢

Find and replace Ctrl+H

vedl wil. viovie

He

Select the text you want to
copy

Press Ctrl + C (Windows) or
Command + C (Mac) to copy

Place your insertion point
where you want the text to
appear

Press Ctrl + V (Windows) or
Command + V (Mac) to paste

Cutting and pasting is the same, except you
will use Ctrl + X instead of Ctrl + V



TECHMB:::  Text editing basics: Insert special characters

Tee Off for Technology ¢ @ Insert special characters

File Edit View Insert Format Tools Add-ons Help
Symbol ¥ Arrows ¥

~ ~ @ A P [ Image >

— 1T =l e 1 N 72NV Q_ Search by keyword (e.g. arrow) or codepoint

il Table B A A ||| T || |«

. . Al e 1 e s ¢ s w

E Drawing > el alul=lelal~

[i] Chart > _— R & O U<« 1 =~

Ll |2|t|ls|e(n|3|u|s

— Horizontal line clelelslclto]t|s|t

Footnote Ctrl+Alt+F D A Kl e Rl Rl Bl

e -l e o e e 8

¢ & » R v @

¢
>
IRE=Y
e
+

tions V
search

() Special characters @ NEIENEEe

{
I
+
+
[nd}
m
—
=
o+
=]

T° Equation

The selected character will appear at your insertion
point




TECHMB:::  Text editing basics: Spelling and grammar

Google Docs will automatically check for
O misspelled words and underline them in red

As you may know, with the recent budget cutbacks in education funding, this annual funraiser is
one of our most important events of the school year. Your donation will help us to reach this
‘ year’s fundraising goal of $10,000 to help support and increase technology resources at

this annual funfaicer ic Ana Af Alir mact imnartant avanta

sing aging comg. Did you mean:
ort the use of te
fundraiser @

o Right click the underlined —r——
> attend our toul

word to see suggested ripurgensrag

om. There will b

spellings and other options .. 5eor

rament and auc
chorus, The Wa

A, Spelling and grammar check Ctri+Alt+X




TECHMB:::  Text editing basics: Find and replace

. Tee Off for Techno|ogy w > 18-hole round of golf at Weston Heights Country Club. It will be considered a big-ticket item
3 . . to be bid upon during the silent-at Lakestone Montessori's 7th annual Tee Off for
File Edit View Insert Format Tools Add-ons Help Technology Charity Golf Tournament. Your donation is a wonderful addition to our auction, and |
predict
~ ~ @ e Undo Ctri+z :
Find and replace X '
As you ndraiser
~ Redo Ctri+Y is one ¢ ich this
year'sfi  Find auction it
Lakestc eto
Cut

purchas Replace with ring
lesson ¢
Copy
D Match case

—- I would ly 14,
Paste Ctrl+Vv i
m 20!(181 Is D Match using regular expressions Help “e”:“”'”
. . . take ple in the
Eﬁ Paste without formatting Ctrl+Shift+V country Ignore Latin diacritics (e. g. = a, E=E) dinner, in
which p generous
Delete s M donors g the
irch meal. A Replace Replace all Previous eciation
s
Select all Ctrl+A for our)
. : We hope you can make it and thank you, once again, for your donation. Please feel free to
+
aciend replace@ G contact me if you have any questions or would like additional information about our tournament

weal il viovie. or silent auction.
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Practice!

e Open the example file and click File > Make a copy

e Delete the last sentence of the third paragraph. The sentence begins e e o
with At the close of the evening .
6
e Use cut and paste or drag and drop to move the second paragraph New

Headin

below the third. The second paragraph starts with As you may know sppear  Open otr+0

Make a copy

e Insert the symbol ® next to the word iPads. You can find this symbol
under the Miscellaneous category

Email

Download

e Use Find and Replace to replace all occurrences of the word donation Meeanisbicane
. . ersion histor >
with gift oo sty

e Run a spell check to make sure all words are spelled correctly. Ignore
the word Alliope



https://docs.google.com/document/d/15pSshNzi2KJ5PSs6LKle9T8GIrKlpyBLnZYDFetc0Tk/edit?usp=sharing
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Here is what the

example
document should

now look like:

June 28, 2018

Justice Moore

IT Security and Solutions Manager
Alliope Systems, Research Triangle Park
456 Davis Drive

Durham, NC 27603

Dear Mr. Moore:

Thank you for your generous gift of a gift certificate for an 18-hole round of golf at Weston
Heights Country Club. It will be considered a big-ticket item to be bid upon during the silent
auction at Lakestone Montessori's 7th annual Tee for Technol: hari olf Tournament.
Your gift is a wonderful addition to our auction, and | predict that it will be a very popular item!

1 would like to invite you and a guest to attend our tournament followed by dinner on July 14,
2018, so that we may recognize you for your generous contribution. This year’s tournament will
take place at 1:00pm at Weston Heights Country Club, and dinner will follow at 6:30pm in the
country club’s Brentwood Banquet Room. There will be a reception 30 minutes prior to dinner, in
which participants will place their final silent bids for items, and then recognition of our generous
donors and announcement of the tournament and auction winners will take place during the
meal.

As you may know, with the recent budget cutbacks in education funding, this annual fundraiser
is one of our most important events of the school year. Your gift will help us to reach this year's
fundraising goal of $10,000 to help support and increase technology resources at Lakestone
Montessori. In addition to replacing aging computer equipment, we would like to purchase 10
Apple iPads® to help support the use of technology in expanding and exploring lesson content.

We hope you can make it and thank you, once again, for your gift. Please feel free to contact
me if you have any questions or would like additional information about our tournament or silent
auction.

Sincerely,
Olenna Mason

(919) 555-2425
lakestone.omason@gmail.com
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Formatting text: Fonts

To change font: To change font size:

. Format Tools Add-ons Help Lastedit was on May 20,2016 Format Tools Add-ons Help Lasteditwas 3 minutes ago

Normal text Calibri v~ - 14 + B I U A » o Normal text  ~ Roboto v = + B I U A »
~ ! M More fonts < > e ' ’ 8 ! !
9
RECENT
10
. Roboto < Thin 1
Ult: )
For Rent ra Light For Rent 12
1488 Villa Pifia v Calibri Normal 1488 Villa Pifia Way #2071 .
Proxima Nova > .
2 bed 1.5 bath Bt 2 bed 1.5 bath 900ft2 18
$1,550 permoy  Aflél Bold $1,550 per month ”s
. Spanlish-style c Bk Spanish-style condo in great loca
Won’t last! Ava Alegreya > Won't last! Available June 1 30
Add-ons Help Last edit was seconds ago

To use bold, italics, or
underline:

2 3 4

RobotoCo.. + = 20 +

To change font color:

r

U

4

A co@EEY =v 1= =~
—

7
00060
000 000000
© ,
0007000000
0000000000
0000000000
0000000000
CUSTOM
[ JO
»® o



TECHMB::: Formatting text: Alignment & spacing

To change text alignment:

® 7o change paragraph spacing:

SEv 12 E~E o 7~ A B
¢ Y Single
‘ 145
1.5
Double 0

Add space before paragraph

@ Add space after paragraph +

Custom spacing

3 4 6 v

To change line spacing:

B E- = 12 - iE- - -~ B
¢ i v Single
1.15
1.5
/)
Double@

To add a hyperlink:

+ B I UA & ooPFMW- =~ 1=

e

~



TECHMB& Headers and footers

Green Valley Animal Rescue ¥ £ &

File Edit View Insert Format Tools Add-ons Help Lastedit was seconds

el -] A/ b 100% Title v Pompiere v = 5 + B i

]

The header appears in the top = 2

O margin of the document, while the

footer appears in the bottom margin I
’Green Va

¢y

NOVEMBER 2020 VOLUNTEER NEWSLETTER

Green Valley Animal Rescue % & ©
File Edit View Insert Format Tools Add-ons Help Lastedit was 9 minutes ago
~ & A T  [& Image » Sans v - 10 + B I U A Green Valley Animal Rescue % & &
Table 3 1 2 3 File Edit View Insert Format Tools Add-ons Help Lasteditwas 11 min
Drawing > ~ o~ @A P 100% ~  Normaltext ~  DroidSans ~ =—= 10 + B
1 v 1 2
[ chart > e

. — Horizontal line |
—_—

Footnote Ctrl+Alt+F
() Special characters e n a ey n I

Header
o i
T Fauation 2020 VOLUNTEER NEWSLETTER Ureen Val Iey
Jm Headers & footers L Header  Ctrl+Alt+0 Ctri+Alt+H
Page numbers > Footer  Ctrl+Alt+0 Ctrl+Alt+F
D Break >

= as been a spectacular month for Green Valley
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aee Page numbers & page breaks

To add page numbers: To add page breaks:

View Insert Format Tools Add-ons Help Lastedit was 3 minute Green Valley Animal Rescue ¥ & &
T [& Image » Sans v - 10 + B 1 File Edit View Insert Format Tools Add-ons Help Last edit was seconds ago
Table » 2 ~ & A T - [ Image > ~ - 10 + B IU
1 2 3
Drawing > /Animal Rescue Table >
[& Chart . [esletter Drawing . FROM YOUR DIRECTOR
— Horizontal line [&] Chart » s been a spectacular month for Green Vi

. . ials in our care! Eight pets found a new hi
Footnote — Horizontal line
1g-time resident of the kennel who was la

e n V a I I e oot CUAIHF, yolunteer favorite, who, in spite of his s
2 speasicnarectes »f humor and a charming transparency -

Equation () Special characters belly rub, a cookie, or an ice cube (his at
2020 VOLUNTEER NEWSLETTER o Ediistlon
a g month for Abner, too, our loveable Lab
Headers & footers " zh the generous donation of Dr. Giuliani's
Page numbers > Headers:&ifooters " 2d much needed hip surgery. He's recove
g p surgery.
— . 1 . Page numbers > and her two young children, who are tea
[
nda = Break 2 @ Page break Ctrl+Enter
@D Link Ctri+K whe i’
& Link Ctrl+K Column break
Comment Ctrl+Alt+M pite ¢ o : oo . gc
spar Comment Ctrl+Alt+M ection break (nextipage)
Bookmark uE : cube Section break (continuous)
Bookmark 5
hey find a home. To all our volunteers - fi
Table of contents > More options veal i f
smie. inrouy )X.G Table of contents > 10se who help with fundraising and speci
Abner receivi He's

Page count
care with Joy : who
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Practice!

e Open the example file and click File > Make a copy

e Insert a header. On the first line, type First Edition; on the
second line, type November 2020.

e Right-align the text you just entered and bold the words First
Edition.

e |n the footer, insert a page number and right-align it.

e |n the footnote, select the hyperlink and use the cut feature to
remove it.

e Select the text ASPCA, Pet Statistics, format it as a hyperlink, ‘
and paste the web address you cut in the previous step.


https://docs.google.com/document/d/1ymPhi1cJ-qMmHNUyd3QLapi0rRbh1OHrntZFeh7qQeE/edit
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Here is what the

example
document should

now look like:

First Edition
November 2020

Green Va”ey Anima| Rescue

NOVEMBER 2020 VOLUNTEER NEWSLETTER

A MESSAGE FROM YOUR DIRECTOR

November has been a spectacular month for Green Valley Animal Rescue
and the animals in our care! Eight pets found a new home, including
Temple, a long-time resident of the kennel who was later fostered by Raj.
Temple was a volunteer favorite, who, in spite of his special needs, had a
great sense of humor and a charming transparency - he wasn't above
begging for a belly rub, a cookie, or an ice cube (his absolute favorite)!

This was a big month for Abner, too, our loveable Lab mix with the silly

smile. Through the generous donation of Dr. Giuliani's time and attention,
Abner received much needed hip surgery. He's recovering nicely in foster OMG /uppfes.’
care with Joy and her two young children, who are teaching Abner to

“speak” while he's on bed rest.

The sad truth about what we do is that approximately 5 to 7 million pets enter animal shelters
nationwide each year. Many of those pets are euthanized before they can be adopted (approximately 3
to 4 million) due to lack of resources, space, and other factors in the shelter environment.'

It's your hard work and dedication that make it possible for us to help shelter animals in need, and
ensure that they find a home. To all our volunteers - from kennel staff, to adoption counselors, to office
helpers, to those who help with fundraising and special events - thank you for all you do.

- Steforno




TECHMB& Track changes and collaborate with others

Select Suggesting in the top right to have Docs track any
changes you make to the document

. @ v 8 Share

Suggesting ~ A

A MESSAGE FROM YOUR DIRECTOR

June has been a grealbpec!eede* month for Green Valley Animal Rescue

/ Editing and the animals in our care! Eight pets found a new home, including @ Anthony Leong v X
Edit document directly Temple, 3 long-time resident of the kennel who was later fostered by Raj. 1:19 PM Today
3 — Temple was a volunteer favorite, who, in spite his special needs, had a Replace: “spectacular” with “great”
. Suggesting great sense of humor and a charming transparency - he wasn't above
Edits become suggestions begging for a belly rub, a cookie, or an ice cube (his absolute favorite)! 2 Reply or add others with @
@ VieWing This was a big month for Abner, too, our loveable Lab mix with the silly A 9 '-‘\?

Read or print final document

. Add comments from the right-click menu (or Ctrl + Alt + M)

spit Explore 'spite his' Ctrl+Alt+Shift+l spite his special needs, had a great sense

arer ' s

» (hi Define ‘spite his’ Ctrl+Shift+Y ‘ arency - he wasn't above begging for a Anthony Leong

2 (i | w3 (his absolute favorite)! 1:26 PM Today
Note typo here.

too, Comment Ctri+Alt+M | too, our loveable Lab mix with the silly yp

1atic 1ation of Dr. Giuliani's time and attention.

Suggest edits

. ) sur |
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Questions? 33

If you would like a copy of this presentation, please let
the instructor know and we will be happy to share.
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Please complete the

survey! You must

complete the survey to N\
recelve your certificate

and have a chance to win

a free desktop computer.



